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Overview 
This document is intended to serve OpenRoads users as a guide that illustrates the 
steps of both creating and annotating cross sections in OpenRoads. 

Process Provenance 
• Date of development: 10/1/2021 
• Revision date: N/A 
• Application/Tool(s): Power GEOPAK V8i SS10 
• Version(s): 08.11.09.918 
• Environment(s): OpenRoads (Enhanced) Workspace 
• Authors: MDT EngOps Workflow Steering Committee 

 

Statement of Need 
Users need a documented workflow for creating and annotating cross sections in 
OpenRoads. This document describes two annotation workflows: the MDT Macro and 
the OpenRoads Tool. Time conditions and project milestone status must be considered 
when deciding which method to use for annotating cross sections. 
The MDT Macro is the preferred workflow because annotation is customizable and in a 
format familiar to road plans checkers. In addition, a preference file can be saved, and 
labels can be redrawn with ease when cross sections are recreated. The MDT Macro 
method requires more initial set up time than the OpenRoads Tool method, but the MDT 
Macro method is more time efficient if cross sections are created and labeled more than 
once within the project’s life. The MDT Macro method is recommended in most cases 
and may be required by checkers upon project delivery. 
The OpenRoads tool is not as customizable as the MDT Macro and does not allow 
preference file saving for future labeling needs. The Annotate Cross Sections tool is 
recommended for use only when cross sections need to be labeled quickly to meet a 
deadline, as most of the labeling is done through presets. 
 

References 
Road Design Manual Section 12.3.12 

Use for cross section labeling requirements. NOTE: This document does not include 
edge of subgrade labeling as current cross section labeling practice deviates from 
this Road Design Manual guidance. The edge of subgrade should not be shown on 
cross sections. 

GEOPAK Criteria User Manual Section 39 

mailto:mdtengopswfcmte@mt.gov
https://www.mdt.mt.gov/other/webdata/external/cadd/RDM/12-RDM-CH12-Plan-Preparation.pdf#page=30
https://www.mdt.mt.gov/other/webdata/external/ESDC/library/GpCritMan.pdf#page=144
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Process Description and Examples 
Section I. File Settings and Setup 
Template point names and feature name overrides are crucial for annotating cross 
sections. 
 
NOTE: Important template points for cross section labeling may include but are not 
limited to the following: 

• Proposed Centerline (CL) 
• Centerline Subgrade (CL_CAC 

Btm) 
• Centerline Existing Ground 

(CL_EX Grnd) 
• Edge of Pavement Top (EOP Top) 

• Hinge Point (EC_Hinge) 
• Ditch Foreslope (EC_Ditch 

Foreslope) 
• Ditch Bottom (EC_Ditch Btm) 
• Excavation Limit Cut 
• Embankment Limit Fill 

 
 
Cut Limit and Fill Limit end conditions have Feature Name Override applied, which 
applies a general name to make annotating more efficient. This document utilizes the 
Feature Name Overrides shown below for Cut Limit and Fill Limit end conditions. 
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Procedure – Corridor File Settings 
Complete the following steps to verify that the TL_Pvmt CL CAC Btm feature 
definition marker “X” will show up when creating cross sections and will allow 
labeling of points with this applied feature definition. 

 
1. Open the project mainline corridor file. 

 
2. Open Project Explorer from the Primary Tools bar. 

 
 

3. Navigate to the Civil Standards tab and expand the following drop-down: 
XXXXXXXRDCRRXXX.DGN > Feature Definitions > MDT_Modeling > Linear. 
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4. Right-click on TL_Pvmt CL CAC Btm and select Properties to open the 
Element Information tab. 

 
 

5. In the Element Information tab, scroll down to the Cross Section heading. 

 
 

6. Click the Element Template drop-down and navigate to MDT Modeling > Points 
> XS_Feature_PointText. Select XS_Feature_PointText. 

 
 

7. Return to the Tasks tab and navigate to Corridor Modeling. Select Process 
Corridor and follow the prompts. This will regenerate the corridor and apply the 
element template, which will allow this feature to be annotated after cross 
sections are created. 
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Alternatively, click on any corridor handle and wait for the contextual tab to 
appear, then click Process Corridor. 

 
 
NOTE: After completing this step, check to see if the superelevation is still 
associated with the model; the superelevation may need to be reassigned to the 
corridor after processing it. It is unlikely that the superelevation will disassociate 
with the model, but it may happen. 
 

8. Repeat Steps 1 - 7 for additional mainline corridor file(s).  
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Procedure – Existing Features File Setup 
Complete the following steps to verify that utilities and other desired survey linework 
will be drawn in the created cross sections. 

 
1. Open the project existing features file. 

 
2. Reference the existing terrain model DGN file into the Default model and set it 

as the active terrain model. 
 

3. Apply appropriate feature definitions to desired lines. 
 

4. Select desired lines, then select Profile From Surface from Vertical Geometry 
task menu and follow the prompts. When prompted to Locate Reference Surface, 
choose Reset for Active Terrain Model. Continue to follow the prompts. 
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Procedure – Cross Section File Setup and Settings 
1. Open the project mainline cross section file. 

 
2. Reference all relevant DGN files into the Default model. 

NOTE: References may include but are not limited to mainline alignment, 
mainline and approach corridors, existing terrain model, existing features, right-
of-way map, and other alignment files. 
 

3. Set the Drawing Scale in the Default and Default-3D models. 
a. Select the drop-down on the Models tab on the Primary Tools bar. To 

navigate between models, double-click the desired model. 

 
 

b. Open the Drawing Scale dialog box from the Settings menu. 

 
 

c. Set the Drawing Scale to 1” = 20’ in the Default model and 1” = 100’ in the 
Default-3D model. Toggle the Annotation Scale ON in both models, as 
shown below. 
 

Default model Default-3D model 
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4. Select references and levels to be displayed when creating cross sections. 
a. Navigate to the Default model. Turn on references and levels that are desired 

to show when creating cross sections. NOTE: Levels must be turned on in 
both the Default references and the XSF Default-3D references. 

 
 

b. Navigate to the Default-3D model. Turn on references and levels that are 
desired to show when creating cross sections. 
 

c. Select Save Settings from the File menu. 
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Section II. Creating Cross Sections 
Procedure – Creating Cross Sections 
1. Select Create Cross Sections from Corridor Modeling task menu and follow 

the prompts. The Create Cross Section dialog box will open. 

 
 
Alternatively, click on the alignment centerline and wait for the contextual tab to 
appear, then select Create Cross Sections. This will open the same dialog box.  

 
 

2. Click Preferences and then select 100 Scale - Stacked from the list of defined 
preferences. Click Load then Close which will populate the setting needed for 
the cross section sheets. 
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3. Verify that the settings match the settings shown below and adjust as needed. 

 
 

4. The Start Station and Stop Station can be defined graphically, or by entering a 
station range. By default, it is set to the beginning and ending stations. A single 
station can also be defined. 
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5. Click Apply. All open views will close and view 6 will open displaying the 
graphics of the new model. If necessary, fit the view graphics. 
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Section III. Annotating Cross Sections – MDT Macro 
Procedure – Annotate Feature Name 
1. Continue in the project mainline cross section file. 

 
2. If not completed already, open the cross section sheet model created from 

Procedure – Creating Cross Sections above. 
 

3. Select Annotate Cross Sections from Corridor Modeling task menu. 

 
 

4. Click Preferences and then select Feature - Name from the list of defined 
preferences. Click Load then Close. 

 
 

5. Click Features then Annotate in the dialog navigation panel. Select the model 
from the Cross Section Model drop-down. 
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6. Select desired points from the Crossing Features list by holding down the Ctrl 
key and selecting, or by using the Select Crosshair tool to select the “X” for the 
desired points. Click Apply. 
 
NOTE: Crossing Features may include but are not limited to the following: 

• Hinge Point 
• Centerline Existing Ground  
• Centerline Subgrade 

• Embankment Limit Fill 
• Excavation Limit Cut 
• Ditch Bottom 
• Ditch Foreslope 
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7. The labels should appear as shown below and will be placed on level 
XS_Label_Point_Text. 

 
 
8. If all desired features are labeled, click Close. Otherwise, repeat Steps 6 - 7. 
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Procedure – Cross Section Labeler: Getting Started 
1. View project GPK file from DMS. 

 
2. Navigate to Road Tools > Cross Sections > XS Feature Labeling as shown 

below. Click XS Feature Labeling and the Cross Section Labeler dialog box 
will open. 

 
 

3. Navigate to the General tab. 
 

4. Set the following settings: Job, Chain, Begin Station, and End Station. 
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Procedure – Cross Section Labeler: Slope Label Setup 
1. Navigate to the Slope Label tab. 

 
2. Select id for the Start Point, select the feature name in the cross section model, 

then left click to accept. 
 

3. Repeat for the End Point. Start and End points should be filled in as shown 
below. 

 
 

4. Double click Symbology and the Slope Label Attributes dialog will open. The 
Slope Label Attributes below are recommended guidance and should be 
altered to meet project needs. NOTE: Label roadway slopes only where 
applicable. 
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Grading: 
• Embankment Limit Fill 
• Excavation Limit Cut 
• Ditch Bottom 
• Ditch Foreslope 

 
Roadway: 

• Normal crown 
• Superelevation 

 
 

5. Select OK on the Slope Label Attributes dialog to accept. 
 

6. Select Add. 
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7. Repeat Steps 1 - 6 for each desired slope label. 
 

8. To modify a label, select the label in the dialog box, modify as needed, then 
select Modify. 
 

9. To delete a label, select the label in the dialog box then select Delete. 
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Procedure – Cross Section Labeler: Elev/Off Label Setup 
1. Navigate to the Elev/Off Label tab. 

 
2. Select id, select the feature name in the cross section model, then left click to 

accept. 

 
 

3. Click the Elevation and/or Offset boxes to check them on as needed. NOTE: 
Offset is not typically labeled but can be utilized for project specific occasions. 
 

4. Double click Symbology and the Elevation Offset Label Attributes dialog will 
open. The Elevation Offset Label Attributes below are recommended guidance 
and should be altered to meet project needs. NOTE: If applicable, adjust Suffix 
Offset based on location to the centerline. 
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Grading & Roadway: 
• Embankment Limit Fill 
• Excavation Limit Cut 
• Ditch Bottom 
• Ditch Foreslope 

  
Subgrade at Centerline 
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Existing Ground at 
Centerline 

 
 

5. Select OK on the Slope Label Attributes dialog to accept. 
 

6. Select Add. 
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7. Repeat Steps 1 - 6 for each desired slope label. 
 

8. To modify a label, select the label in the dialog box, modify as needed, then 
select Modify. 
 

9. To delete a label, select the label in the dialog box then select Delete. 
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Procedure – Cross Section Labeler: Saving Preference File 
1. Select Annotate Cross Sections from Corridor Modeling task menu. 

 
 

2. Set the file name to [8-digitUPN] RDXSI001. For example, 9116000RDXSI001. 
 

3. Upload the .xlp file to DMS. Check out and update as needed. 
 

4. If in an open preference file and it is necessary to save changes, select Save 
settings to an open preference file. 
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Procedure – Cross Section Labeler: Drawing Cross Section Labels 
1. View project .xlp file from DMS or see Cross Section Labeler sections above. 

 
2. Repeat Steps 1 - 2 of Procedure – Cross Section Labeler: Getting Started. 

 
3. Select Open an existing preference file. Select the project .xlp file. 

 
 

4. Repeat Steps 3 - 4 of Procedure – Cross Section Labeler: Getting Started. 
 

5. Click Draw Labels. NOTE: This will draw all labels in the Slope Label, Elev/Off 
Label, Sta Label, and Text Label tabs. 

 
 

6. To undo recently drawn labels select Undo. NOTE: Previous labels cannot be 
undrawn once the Cross Section Labeler dialog box has been closed. 
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7. To delete previous labels after closing the Cross Section Labeler dialog box, 
open the Element Section dialog box, click the drop-down arrow, select the 
appropriate levels, and click Delete on the keyboard. 

 

 
 

8. To draw additional cells that were not drawn when creating cross sections (such 
as right-of-way or wetlands), use the GEOPAK Draw Ancillary Features tool. 
Guidance can be found in the GEOPAK Criteria User Manual. NOTE: The cell 
library mentioned in Step 12 is now located at the following location: \\state\mdt\ 
prd\Helena\CaddStandards\Bentley\OpenRoads\OPENROADS\cell\RD_XS.  
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Section IV. Annotating Cross Sections – OpenRoads Tool 
Procedure – Annotate Cross Sections: Feature – CL Existing 
Ground 
1. Select Annotate Cross Sections from Corridor Modeling task menu. 

 
 

2. Click Preferences and then select Feature - CL Existing Ground from the list of 
defined preferences. Click Load then Close. Select the existing active terrain 
model from the Surface drop-down. 

 
 

3. Click Features then General in the dialog navigation panel and verify that 
settings match the settings shown below.  
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4. Click Annotate under the Features folder in the dialog navigation panel. Select 
the model from the Cross Section Model drop-down. 

 
 

5. Select the centerline existing ground (CL_EX Grnd) from the Crossing Features 
list, or by using the Select Crosshair tool to select the “X” for the desired point. 
Click Apply. 
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6. The label should appear as shown below and will be placed on level 
XS_Label_Feature_Text. 

 
 

7. Click None to clear the Crossing Feature selection before proceeding to the 
next procedure. NOTE: If this step is not performed, previous selections will 
remain active in the other annotation preferences and will be labeled with other 
features. 
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Procedure – Annotate Cross Sections: Feature – CL Subgrade 
1. Continue in the Annotate Cross Section dialog box. 

 
2. Click Preferences and then select Feature - CL Subgrade from the list of 

defined preferences. Click Load then Close. Select the active terrain model from 
the Surface drop-down. 

 
 

3. Click Features then General in the dialog navigation panel and verify that 
settings match the setting shown below.  
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4. Click Annotate under the Features folder in the dialog navigation panel. Select 
the model from the Cross Section Model drop-down. 

 
 

5. Select the centerline proposed subgrade (CL_CAC Btm) from the Crossing 
Features list, or by using the Select Crosshair tool to select the “X” for the 
desired point. Click Apply. 
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6. The label should appear as shown below and will be placed on level 
XS_Label_Feature_Text. 

 
 

7. Click None to clear the Crossing Feature selection before proceeding to the 
next procedure. 
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Procedure – Annotate Cross Sections: Feature – Elev/Offset 
1. Continue in the Annotate Cross Section dialog box. 

 
2. Click Preferences and then select Feature – Elev/Offset from the list of defined 

preferences. Click Load then Close. Select the active terrain model from the 
Surface drop-down. 

 
 

3. Click Features then General in the dialog navigation panel and verify that 
settings match the settings shown below. NOTE: The Offset box will be checked 
ON with the default preferences loaded. Offsets are not typically labeled for final 
plans production; therefore, uncheck the Offset box. If offset labeling is required 
for project specific occasions, “LT.” and “RT.” denotations can be added to the 
Offset Suffix column based on location to the centerline. Please note that a 
negative, “-”, denotation will be placed in front of any offset left of the centerline. 
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4. Click Annotate under the Features folder in the dialog navigation panel. Select 
the model from the Cross Section Model drop-down. 

 
 

5. Select desired points from the Crossing Features list by holding down the Ctrl 
key and selecting, or by using the Select Crosshair tool to select the “X” for the 
desired points. Click Apply. 
 
NOTE: Crossing Features may include but are not limited to the following: 

• Embankment Limit Fill 
• Excavation Limit Cut 

• Ditch Bottom 
• Ditch Foreslope 
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6. The labels should appear as shown below and will be placed on level 
XS_Label_Feature_Text. 

 

 
 

7. Click None to clear the Crossing Feature selection before proceeding to the 
next procedure. 
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Procedure – Annotate Cross Sections: Segment – Percent Labels 
This procedure provides guidance on how to label roadway slopes, if applicable. 

 
1. Continue in the Annotate Cross Section dialog box. 

 
2. Click Preferences and then select Segment – Percent Labels from the list of 

defined preferences. Click Load then Close. Select the current corridor surface 
from the Surface drop-down. 

 
 

3. Click Segments then General in the dialog navigation panel and verify that 
settings match the settings shown below. 

 
 



Montana Department of Transportation - Creating and Annotating Cross Sections 

 

Annotating Cross Sections – OpenRoads Tool PAGE 39 | 46 

 

4. Click Annotate under the Segments folder in the dialog navigation panel. Select 
the model from the Cross Section Model drop-down. 

 
 

5. Select desired points from the Crossing Features list by holding down the Ctrl 
key and selecting, or by using the Select Crosshair tool to select the “X” for the 
desired points. Click Apply. 
 
NOTE: Crossing Features may include but are not limited to the following: 

• Edge of Pavement Top 
• Proposed Centerline 

 
 



Montana Department of Transportation - Creating and Annotating Cross Sections 

 

Annotating Cross Sections – OpenRoads Tool PAGE 40 | 46 

 

6. The labels should appear as shown below and will be placed on level 
XS_Label_Segment_Text. 

 
 

7. Repeat Steps 1 - 6 for additional mainline corridors in the Surface drop-down. 
 

8. Click None to clear the Crossing Feature selection before proceeding to the 
next procedure. 

  



Montana Department of Transportation - Creating and Annotating Cross Sections 

 

Annotating Cross Sections – OpenRoads Tool PAGE 41 | 46 

 

Procedure – Annotate Cross Sections: Segment – Run:Rise Labels 
1. Continue in the Annotate Cross Section dialog box. 

 
2. Click Preferences and then select Segment – Run:Rise Labels from the list of 

defined preferences. Click Load then Close. Select the current corridor surface 
from the Surface drop-down. 

 
 

3. Click Segments then General in the dialog navigation panel and verify that 
settings match the settings shown below. 

 
 

4. Click Annotate under the Segments folder in the dialog navigation panel. Select 
the model from the Cross Section Model drop-down. 
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5. Select desired points from the Crossing Features list by holding down the Ctrl 
key and selecting, or by using the Select Crosshair tool to select the “X” for the 
desired points left of centerline. Click Apply. 
 
NOTE: Left-side Crossing Features may include but are not limited to the 
following: 

• L_Embankment Limit Fill 
• L_EC_Hinge 

• L_Excavation Limit Cut 
• L_EC_Ditch Btm 
• L_EC_Ditch Foreslope  
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6. The labels should appear as shown below for points left of centerline and will be 
placed on level XS_Label_Segment_Text. 

 
 
NOTE: If points right of centerline are included with this portion of labeling, slope 
labels willl appear between the left and right hinge points and the process will 
need to be undone and repeated. 
 

7. Click None to clear the Crossing Feature selection before proceeding. 
 

8. Repeat Steps 1 - 4. 
 

9. Select desired points from the Crossing Features list by holding down the Ctrl 
key and selecting, or by using the Select Crosshair tool to select the “X” for the 
desired points right of centerline. Click Apply. 
 
NOTE: Right-side Crossing Features may include but are not limited to the 
following: 

• R_Embankment Limit Fill 
• R_EC_Hinge 

• R_Excavation Limit Cut 
• R_EC_Ditch Btm 
• R_EC_Ditch Foreslope  
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10. The labels should appear as shown below for points right of centerline and will be 
placed on level XS_Label_Segment_Text. 

 
 

11. After completing the labeling process, the cross sections produced should 
resemble the one below: 

 
 

12. If needed, repeat Step 8 of Section III, Procedure – Cross Section Labeler: 
Drawing Cross Section Labels, to draw additional cells in the cross section model 
by using the GEOPAK Draw Ancillary Features tool.  
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Section V. Updating Cross Sections 
Procedure – Cross Section Synchronization Macro 
The following macro was created to address the problem of transferring notes and 
other hand-edited information when a new cross section model is created by utilizing 
OpenRoads software.  
 
1. Open the project mainline cross section file. 

 
2. Follow the procedures above to create and annotate a new cross section model. 

NOTE: Do not delete the old cross section model. 
 
If not already, open the new cross section model. To do this, select the drop-
down on the Models tab on the Primary Tools bar. Double-click the new cross 
section model to open this model. NOTE: For this example, the new cross 
section model is NEW_COLUMBUS_CL, and the old cross section model is 
COLUMBUS_CL. 

 
 

3. In the new cross section model, navigate to the Road Tools > Cross Sections > 
XS Sync as shown below. Click XS Sync and the Synchronize XS Graphics 
dialog box will open. 
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4. Select the old cross section model in the Source Model drop down menu. The 
Target Model will be the new cross section model. 

 
 

5. Select desired levels to be copied to the new cross section model. NOTE: For 
this example, one EXAMPLE NOTE has been placed on Level 1. 

 
 

6. Click Process. All selected levels will be copied to the new cross section model 
at the corresponding station as the old cross section model. NOTE: If a cross 
section station no longer exists in the new cross section model, levels located on 
the old station cross section will not be copied over. 
 

7. A dialog box will appear detailing the number of elements copied. Click OK and 
close the Synchronize XS Graphics dialog box. 
 

8. Items on the selected levels will appear in the new cross section model as shown 
below. 
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